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General Information

Welcome to Pretty Good Solitaire! This program started because | was unsatisfied with the solitaire
programs out there. There's some good ones, but usually they come only 1 or 2 games at a time,
with no undo feature, and so on. And so | started to write my own. It all started with FreeCell, and
the first version had 5 games. It's now grown to 60 games.

Every game has full undo and redo (except for when the deck is reshuffled).  The first time you play
the game, you will be asked for your name. You can add new player names (or delete them) at any
time, so more than one person can use Pretty Good Solitaire. All the game settings are saved
independently for each player, so if you like AutoPlay and someone else doesn't, you don't have to
keep turning it on and off all the time!

In addition, Pretty Good Solitaire will keep a record of your wins and losses in each game, for each
player. You can reset the statistics at any time. You can even turn off the statistics keeping (see
Options menu), if you want to play a game you don't want counted.

One of the best features of Pretty Good Solitaire, in my opinion, is the game saving. When you exit,
the program will automatically remember your game position. When you restart the program, you
can continue right where you left off. You can turn off game saving if you like (see the Options
menu).

Another great feature are the mouse shortcuts. Double-clicking on the left mouse button moves a
card to the foundations. Right clicking on a card in most games will either move a card to the
foundations or a tableau pile. By right clicking, you can make moves without drag and drop and also
determine whether a card can be legally moved. For more information, see the Mouse Shortcuts
topic.

Mouse Shortcuts

If you can't decide which of the 60 games to play, you can have the program select one at random
(See the Game menu).

New to version 2.1: Pretty Good Solitaire now has tours (see the Tours menu from the main screen.
Tours are sequences of games where a cumulative score is kept. If you have several games you
like to play often, you can put them together in a tour and keep score!

Important Notes about the AutoPlay feature
Windows 95 Issues

Screen Resolution Issues
Benefits of Registration



Mouse Shortcuts

Double-clicking (left mouse button)

In games with Foundations, double-clicking on a card with the left mouse button will move the card to
the foundation, if that move is legal.

Clicking with the right mouse button

In most games, clicking on a card with the right mouse button will do the following:

1 Move the card to the Foundation, if there is a Foundation and if that move is legal. (same as
double-clicking with the left button above).

2 Failing number 1, it will move the card to a tableau pile, if there is such a legal move. It will
check first for legal moves to non-empty tableau piles (moving from left to right). Then it will
look for moves to empty tableau piles (again, moving from left to right).

Using the right button can speed play in a game dramatically. Note however, that the right mouse
button does not work in every game, and that it may not move the card where you want to move the
card. But it usually will.

Clicking on a card with the right mouse button is a good way to check to see if there are any legal
moves for that card. If there is a legal move, clicking on the right mouse button will probably move
the card. If there isn't, it won't.



Notes about the AutoPlay feature

AutoPlay

AutoPlay is the feature that moves playable cards from the tableau to the foundations automatically.
(Only those games with foundations have this feature, of course.) This feature can be a great time
and effort saver, and | highly recommend its use.

However, there are a couple of things about AutoPlay that you should be aware of. First, in some
games (such as FreeCell, Yukon, etc) it is not necessarily a good idea to automatically play every
possible card to the foundations. In these games, the best strategy is to keep the foundations pile
roughly even with each other (for example, don't play the clubs foundation pile up to 5 or 6 when the
ace of hearts hasn't come out yet). Because of this, the AutoPlay feature will NOT play a card to the
foundations if it determines that that card might be necessary for play on the tableau. You can, of
course, override this if you wish by playing the card to the foundations yourself. But remember, if
AutoPlay doesn't move a card that it could move, there's a reason.

Secondly, although in many games it is technically cheating, these games allow you to move a card
from the foundations back to the tableau, if you wish. However, if AutoPlay is turned on, the
AutoPlay feature will promptly play the card back to the foundation! Therefore, if you ever want to
do this you will need to turn AutoPlay off.



Auto Play

By selecting Auto Play from the Options menu, any cards in the tableau or cells that can be legally
moved to the foundation are automatically moved there. This speeds up play.

Important Notes about the AutoPlay feature



Windows 95 Issues

Pretty Good Solitaire was developed on and intended for Windows 3.1. However, the final stages of
its development was in Windows 95, and it runs fine in Windows 95. There are a few things Win95
users should be aware of, however.

If you run Win95 with a screen resolution of 800x600 or more, you should have no difficulties. You
may want to resize the game window to your liking. | recommend placing the taskbar at either the
top or bottom of the screen, as most of the games like as much horizontal space as possible.

Screen Resolution Issues

The main problems with Pretty Good Solitaire and Windows 95 occur at 640x480 resolution. The
problem is the taskbar, and how much valuable space it takes up. This screen just ain't big enough
for the both of 'em. The taskbar will cause serious problems, particularly in La Belle Lucie and
Shamrocks. In these game especially, | recommend hiding the taskbar (this can be done by clicking
on the start button, selecting Settings and then Taskbar, and setting AutoHide on). In the other
games, the taskbar is tolerable, but still, you can give yourself more space by getting rid of it.



Screen Resolution Issues

Pretty Good Solitaire was developed to run in 640x480 mode, except for those games in the
800x600 section. However, if you run it in higher resolutions, you can resize the game window to
make it bigger. Pretty Good Solitaire will then adjust to the bigger window the first time you do a
"New Game". This will spread out the piles. Pretty Good Solitaire will remember how big you made
the window and always run at that size.

You can adjust the size of the game window at any time. Pretty Good Solitaire will always adjust to
a new window size after a "New Game".

Note: If you switch resolutions and play a game that was previously played at another resolution, you
will need to "New Game" to get Pretty Good Solitaire to adjust to the new resolution.



Benefits of Registration

The registration price for this program is only $19!  This program is shareware, and if you use it for
longer than a 30 day evaluation period, you should register the program. Supporting shareware
development will result in better programs.

If you do register this program, this is what you will get for your money:

e Aregistration code and instructions on how to input this code to register your copy of Pretty
Good Solitaire. This process will get rid of the registration notices. (Your registration code will
be sent by e-mail if you specify an e-mail address; otherwise, it will be sent by regular mail).

e Free upgrades to all future versions, if you have a Compuserve, America Online, Prodigy, or
Microsoft Network account, or if you have an e-mail program that is capable of decoding files
encoded in the internet standard MIME 2.0 encoding format. These upgrades will be sent by e-
mail, so be sure to include your e-mail address on the registration form if you wish to take
advantage of this benefit. | will not send upgrades by regular postal mail. Note also that the
latest version is always available for download from my World Wide Web site.

e Technical support, via e-mail.

e The eternal gratitude of the author.

My Registration/Customer Support Policy
You can register online on the Compuserve service by GO SWREG. The registration number is
#8322. You will be sent your registration code by e-mail, as well as any future upgrades.

Registration Form



Customer Support

What happens when you register:

When you register Pretty Good Solitaire, | will generate a unique registration code just for you and
send it to you. This code will register your copy of Pretty Good Solitaire. If you give an e-mail
address on your registration code, | will send you the registration code by e-mail, usually within 24
hours of when | receive your check (unless | am out of town). If you register via CompuServe's
SWREG service (GO SWREG), you will usually get your code within 24 hours of when you register
(again, unless | am out of town). If you don't provide an e-mail address, then your code will be sent
to you via regular mail, meaning that when you get it will depend on the post office.

Once registered, your code will work for all future versions of Pretty Good Solitaire. If you provide
an email address, | can send you future versions by email. Or, you can always check out my World
Wide Web site for the latest versions of Pretty Good Solitaire and all my other products.

As a registered user, you will be able to legally use the program beyond the 30 day trial period, and
have full access to all features. Please support the shareware concept!

My Distribution method:

My distribution method is simple: the internet. | see little point in any other way of distributing
shareware. My World Wide Web site always has the latest version available. | can also always
send you the latest version by email, if you request. If you have any questions about Pretty Good
Solitaire, send me an email. | try to reply to all messages as quickly as | can.

| generally do not send out diskettes. By not sending diskettes, | save on expenses, and therefore |
am able to charge less than competing products. You won't find another solitaire package with as
many games for as low a price as Pretty Good Solitaire. The reason is that | can save you a few
dollars by not sending diskettes. | do send out diskettes when people request them for special
circumstances, but in these days when nearly everyone is getting modems and net access, using
mail to distribute software is archaic.

International Users:

Pretty Good Solitaire has developed a pretty good following outside the United States. | wish that |
had a convenient method for non-Americans to register, but at the moment | do not. If you have a
CompuServe account, you can use the SWREG service to register easily. | am trying to find a good
Web registration service, but so far | have not found one that meets my needs. If it has been a few
months since this version was released, you might want to check out my web site to see if | have
found a registration service. Until then, you can always send an International Money Order.



Registration Form

Pretty Good Solitaire 2.1

Print out this form. (To print, select Print from the File menu.)

Send this form along with a check or money order for $19 in U.S. dollars (Canadian dollars also
accepted, please calculate exchange rate) to:

Thomas Warfield
PO Box 9155
Springfield IL  62791-9155 USA

You can register online on Compuserve: GO SWREG, registration #8322.

Name

Address

City State/Province
Zip Code/Postal Code Country

E-Mail address

If a Compuserve, Prodigy, America Online, or Microsoft Network account, or if you can receive files
encoded in MIME 2.0 format, you can receive upgrades by e-mail. Check here if you wish to
receive upgrades by email

Where did you hear about or find Pretty Good Solitaire?

Suggestions:

CIE210



How to Play

Klondike type
Canfield type

2 Deck games

800 x 600 games
Simple games
Miscellaneous games



Klondike type

Klondike
EastHaven
Scorpion
Spiderette

Spidike

Thumb and Pouch
Whitehead

Will o the Wisp
Yukon



Klondike

1 Deck.

Object

To move all the cards to the Foundations.

Layout
e 4 Foundation piles (top right) - build up in suit from Ace to King.

e 7 Tableau piles (below foundations) - build down by alternate color. Move groups of cards if
they are in sequence. Fill spaces with Kings or groups of cards with a King at the bottom.

e Stock (top left, face down) - turn over 3 cards at a time, by clicking. Unlimited redeals.
e Waste (next to Stock) - Top card always available for play.

Options
Rules - selects whether 1 card or 3 cards at a time are turned over from the Stock.

KingOnly
AutoPlay
Play

28 cards are dealt into 7 tableau piles, the number of cards increasing from 1 to 7 as you go from left
to right. The top card of each pile is face up, the others face down. The rest of the cards go face
down in the stock.

Move Aces to the Foundations as they become available. Build the Foundations up in suit. Build
the Tableau piles down by alternate color. The top card of each Tableau pile is available for play on
another Tableau pile or the Foundations. Groups of cards in the proper sequence can be moved as
a unit. Spaces in the Tableau can be filled only by Kings (or a group of cards with a King at the
bottom) if KingOnly is checked.

Cards are turned up from the Stock (by clicking on the Stock) and placed in the waste pile, either one
at a time or three at a time, depending on the Rules setting in the Options menu. When the Stock is
empty, click on the empty Stock to move the cards in the Waste pile back into the Stock. There is
no limit on the number of times you can go through the deck.

History

Klondike is basic Windows solitaire (the game that comes with Windows). It probably dates back to
the Klondike gold rush of the late 19th century. It is known by many names, including Chinaman,
Fascination, Triangle, Patience, and Solitaire. In England it is often called Canfield. This version is
actually a variation of the real Klondike, which does not allow redeals.



King Only
By selecting King Only from the Options menu, you can only fill an empty tableau pile with a King.
With this not selected, any card can be placed in an empty tableau pile.



EastHaven
1 Deck.

Object

To move all the cards to the Foundations.

Layout
e 4 Foundation piles (top right) - build up in suit from Ace to King.

e 7 Tableau piles (below Foundations) - build down in alternating colors. Move groups of cards in
descending sequence of alternate colors. Fill spaces with Kings or groups of cards with a King
at the bottom. All spaces must be filled before a row can be dealt from the Stock.

e Stock (top left) - Clicking deals a row of 1 card to each Tableau pile.
Options

KingOnly

AutoPlay

Play

At the beginning of the game, 3 cards are dealt face down to each Tableau pile. Then 1 card is dealt
face up on each pile.

Move Aces to the Foundations as they become available. Build Foundations up in suit to Kings.
Build Tableau piles down in alternate colors. The top card of each Tableau pile is available for play
on another Tableau pile or the Foundations. Groups of cards in the tableau may be moved, as long
as they form a descending sequence of alternating colors. When the KingOnly option in the Options
menu is set, an empty space can only be filled by a King or a legal group of cards with a King at the
bottom. When KingOnly is not set, an empty space can be filled by any legal group of cards.

Whenever there are no more possible plays on the Tableau, another group of 7 cards is dealt to the
tableau by clicking on the Stock. One card from the Stock is then placed face up on each tableau
pile (note that this may block out the previous cards). The last 3 cards of the Stock are dealt to the
first 3 Tableau piles.

History

EastHaven is a variation of Klondike. It is also known as Aces Up. The difficult part of this game is
that the new cards dealt can completely ruin the tableau. Not checking the KingOnly option makes
the game somewhat easier to win.



Scorpion
1 Deck.

Object

To get all the cards into 4 13-card suit sequences in the Tableau.

Layout

e 7 Tableau piles (top) - build down by suit. Groups of cards (regardless of sequence) can be
moved. Fill spaces with Kings or groups of cards with a King at the bottom.

e Reserve (top left) - Clicking deals 1 card to each of the first 3 Tableau piles.

Options
KingOnly
Play

49 cards are dealt to the tableau in 7 piles. In the first 4 piles, 3 cards are face down; in the others,
all are face up. The 3 remaining cards form the Reserve, face down left of the tableau. There are
no Foundations.

The object of play is to manipulate the tableau into 4 piles, one for each suit, with the cards in
sequence from king to ace. The tableau piles are built down by suit; for example, a 10 of hearts can
be played on a Jack of hearts. Any card, regardless of where in a pile it is, can be moved, along
with all cards above it (this is like Yukon). A space created by moving an entire pile can only be
filled with a King (if KingOnly is checked). When a face-down card becomes the top card of a pile, it
is turned face up.

Should there ever be no more possible moves, the 3 cards in the Reserve can be dealt to the
Tableau by clicking on the reserve pile. These 3 cards are dealt on top of the 3 leftmost Tableau
piles. Play is then continued as before. If no more moves are then possible, the game is lost.

History

This game is related to Spider. It is imperative that the face down cards be uncovered as soon as
possible. There are often several choices of builds to make and it is beneficial to work through
possibilities. This is very much a game of skill, and it is difficult.



Spiderette

1 Deck.

Object

To get all the cards into four 13-card suit sequences.

Layout

e 7 Tableau piles - build down regardless of suit. Groups of cards in descending sequence in suit
may be moved as a unit. Fill spaces with any card.

e Stock (above the Tableau) - Clicking deals 1 card to each Tableau pile. All empty spaces must
be filled before a deal.

Options
Rules - choose between Regular Spiderette and Baby Spiderette (which allows groups of cards in
descending sequence regardless of suit to be moved as a unit).

Play

28 cards are dealt to the Tableau as in Klondike. The tableaus are built down in sequence,
regardless of suit. However, building down by suit is preferable. The top card of each pile is
always available for play on another pile, and multiple cards at the top of a pile that are of the same
suit and down in sequence may also be moved as a unit.

A space created by moving an entire pile may be filled by any card or any legal group of cards.
Whenever there are no more possible plays, a row of 7 cards can be dealt to the Tableaus by clicking
on the face down card above the tableaus. All empty piles must be filled before the deal.

The object of the game is to get all 13 cards of each suit in sequence in a pile. Whenever the 13
cards of suit are assembled in sequence, the program will automatically remove them from play.
You win by getting all 52 cards removed.

History
Spiderette is a cross between the popular games Klondike and Spider. The game Will o the Wisp is
also closely related.

Since pure Spiderette is fairly difficult to win, the program offers a rules option that is easier to win.
To change the rules, select "Rules" from the Options menu.

Baby Spiderette is considerably easier than regular Spiderette. In Baby Spiderette, the tableau is
the same as regular Spiderette, as are all the rules except one. In Baby Spiderette, you are allowed
to move a group of cards as a block if they are in sequence regardless of suit. In Spiderette, they
must all be of the same suit. This makes it easier to move cards around, and easier to win the
game.



Spidike

1 Deck.

Object

To move all the cards to the Foundations.

Layout
e 4 Foundation piles (top right) - build up in suit from Ace to King.
e 7 Tableau piles (below foundations) - build down regardless of suit. Move groups of cards only if

they are in descending sequence by suit. Fill spaces with Kings or groups of cards with a King
at the bottom.

e Stock (top left, face down) - clicking on the stock deals 1 card to each Tableau pile.
Options

KingOnly

AutoPlay

Play

28 cards are dealt into 7 tableau piles, the number of cards increasing from 1 to 7 as you go from left
to right. All of the cards are face up. The rest of the cards go face down in the stock.

Move Aces to the Foundations as they become available. Build the Foundations up in suit. Build
the Tableau piles down regardless of suit. The top card of each Tableau pile is available for play on
another Tableau pile or the Foundations. Groups of cards in descending sequence in suit can be
moved as a unit. Descending sequences of different suits cannot be moved as a group. Spaces
in the Tableau can be filled only by Kings (or a group of cards with a King at the bottom) if KingOnly
is checked.

Clicking on the stock deals 1 card to each Tableau pile. The game is won when all cards are moved
to the Foundations.

History

Spidike is a type of cross between Spider and Klondike. The tableau building rules and the dealing
of cards to the tableau is Spider (or Spiderette) like, but the Tableau starts out much like Klondike.
The game is much more challenging with the KingOnly option set. Spidike was invented by the
author of Pretty Good Solitaire, Tom Warfield.



Thumb and Pouch

1 Deck.

Object

To move all the cards to the Foundations.

Layout
e 4 Foundation piles (top right) - build up in suit from Ace to King.

e 7 Tableau piles (below Foundations) - build down by any suit but the same. Move groups of
cards if they are in sequence. Fill spaces with any card or legal group of cards.

e Stock (top left, face down) - Clicking turns over 1 card to Waste pile. No redeal.

e Waste (next to Stock) - Top card always available for play.

Options

AutoPlay

Play

28 cards are dealt into 7 tableau piles, the number of cards increasing from 1 to 7 as you go from left
to right. The top card of each pile is face up, the others face down. The rest of the cards go face
down in the Stock.

Move Aces to the Foundations as they become available. Build the Foundations up in suit. Build
the Tableau piles down by any suit but the same. That is, any 5 but the 5 of hearts can be played on
a 6 of hearts. The top card of each Tableau pile is available for play on another Tableau pile or the
Foundations. Groups of cards in the proper sequence can be moved as a unit. Spaces in the
Tableau can be filled by any card or any legal group of cards.

Cards are turned up from the Stock (by clicking on the Stock) and placed in the waste pile one at a
time. There is no redeal.

History

This is a variation of Klondike. It is fairly easy to win.



Whitehead

1 Deck.

Object

To move all the cards to the Foundations.

Layout
e 4 Foundation piles (top right) - build up in suit from Ace to King.

e 7 Tableau piles (below foundations) - build down by same color. Move groups of cards if they
are in descending sequence by suit. Fill spaces with any card or legal groups of cards.

e Stock (top left, face down) - turn over one card at a time, by clicking. No redeals.
e Waste (next to Stock) - Top card always available for play.

Options

AutoPla

Play

28 cards are dealt into 7 tableau piles, the number of cards increasing from 1 to 7 as you go from left
to right. All the cards are dealt face up. The rest of the cards go face down in the Stock.

Move Aces to the Foundations as they become available. Build the Foundations up in suit. Build
the Tableau piles down by same color, red on red, black on black. The top card of each Tableau pile
is available for play on another Tableau pile or the Foundations. Groups of cards in descending
sequence by suit can be moved as a unit. Spaces in the Tableau can be filled by any card, or any
legal group of cards.

Cards are turned up from the Stock (by clicking on the Stock) and placed in the waste pile one at a
time. There are no redeals.

History

This is a variation of Klondike. The ability to see all the cards in the Tableau makes this game
interesting. It is more difficult to win than most of the Klondike variations.



Will o the Wisp

1 Deck.

Object

To get all the cards into four 13-card suit sequences.

Layout

e 7 Tableau piles - build down regardless of suit. Groups of cards in descending sequence in suit
may be moved as a unit. Fill spaces with any card.

e Stock (above the Tableau) - Clicking deals 1 card to each Tableau pile. All empty spaces must
be filled before a deal.

Play

21 cards are dealt to the Tableau, 2 face down to each pile, then 1 face up to each pile. The
tableaus are built down in sequence, regardless of suit. However, building down by suit is
preferable. The top card of each pile is always available for play on another pile, and multiple cards
at the top of a pile that are of the same suit and down in sequence may also be moved as a unit.

A space created by moving an entire pile may be filled by any card or any legal group of cards.
Whenever there are no more possible plays, a row of 7 cards can be dealt to the Tableaus by clicking
on the face down card above the tableaus. All empty piles must be filled before the deal.

The object of the game is to get all 13 cards of each suit in sequence in a pile. Whenever the 13
cards of suit are assembled in sequence, the program will automatically remove them from play.
You win by getting all 52 cards removed.

History

Will o' the Wisp is a variation of Spiderette with exactly the same rules, except that 21 cards are dealt
to the tableau at the beginning of the game instead of 28. (The cards are dealt in the same fashion
as EastHaven). With fewer face down cards to clear, the game becomes slightly easier.



Yukon

1 Deck.

Object

To move all the cards to the Foundations.

Layout
e 4 Foundation piles (top right) - build up in suit from Ace to King.

e 7 Tableau piles (below foundations) - build down by alternate color. Move groups of cards
regardless of sequence. Fill spaces with Kings or groups of cards with a King at the bottom.

Options
AutoPlay
Play

28 cards are dealt into 7 piles, face down as in Klondike. Then the remaining 24 cards are dealt
face up in the rightmost 6 piles, 4 in each pile.

Move Aces as they become available to the Foundations. The Foundations are built up in suit. The
Tableaus are built down by alternate color.  For example, a red 6 can be dropped on a black 7 (no
cards can be built on an Ace). Any face up card in the tableau may be built upon another, no matter
how deep it is in a pile. All cards covering it are moved together. When a face down card is
uncovered, it is automatically turned face up and is available for play. Spaces created by moving an
entire pile can be filled only with Kings.

History

Yukon is a variation of Klondike. Uncover the face down cards as soon as possible. Don't let one
foundation get too far ahead of the others. This game is moderately difficult, and is a game of skill.
It is the best and most addictive game in the Klondike group.



Canfield type

Canfield
Chameleon
Duke
Storehouse



Canfield

1 Deck.

Object

To move all the cards to the Foundations.

Layout
e 4 Foundation piles (top right) - build up in suit from the first card dealt, wrapping from Ace to King
as necessary.

e 4 Tableau piles (below foundations) - build down by alternate color. Move groups of cards if
they are in sequence. Spaces are filled from the Reserve if possible, then by any card.

e Stock (top left, face down) - turn over 1 or 3 cards at a time, by clicking. Unlimited redeals.
e Waste (next to Stock) - Top card always available for play.
¢ Reserve (left of Tableau) - Top card always available for play.

Options
Rules - selects whether 1 card or 3 cards at a time are turned over from the Stock.

AutoPlay
Play

13 cards are dealt to a pile called the Reserve. A 14th card is dealt above and to the right of the
Reserve. This becomes the first of 4 Foundation piles. As cards of the same rank appear, they will
be moved to the other 3 Foundation piles. (ie. if the first Foundation pile started with a 5, the other
three 5's will be moved to the other Foundation piles as they appear). The Foundation piles will be
built up in suit, wrapping around from King to Ace as necessary. Below the Foundations, 4 cards
are dealt out to form 4 Tableau piles. The Tableau piles are built down by opposite colors, wrapping
around from Ace to King as necessary. For example, in the Tableaus a red 8 could be played on a
black 9. Entire Tableau piles can be moved onto other Tableau piles, if possible.

The remainder of the deck is placed face-down in the Stock. Stock cards are played (by clicking on
the Stock) either one or three at a time to the waste pile (depending on the Rules setting in the
Option menu). The top card of the wastepile is available for play on the Tableaus or Foundations.
Empty spaces in the tableau are filled from the reserve, or when the reserve is empty from the
wastepile.

When the Stock is empty, the wastepile can be moved back to the Stock by clicking on the empty
Stock. There is no limit on the number of times the Stock can be run through.

The game is won if all the cards are moved to the foundations.

History

Canfield is named after the owner of a gambling salon in Saratoga, who sold decks of cards to
customers for $50 and paid 5 dollars for each card played to the Foundations during the game. In
England this game is called "Demon".






Chameleon
1 Deck.

Object

To move all the cards to the Foundations.

Layout

e 4 Foundation piles (top right) - build up in suit from the first card dealt, wrapping from Ace to King
as necessary.

e 3 Tableau piles (below foundations) - build down regardless of suit. Move groups of cards if
they are in sequence. Spaces are filled from the Reserve if possible, then by any card.

e Stock (top left, face down) - turn over one card at a time, by clicking. There is no redeal.

e Waste (next to Stock) - Top card always available for play.

¢ Reserve (left of Tableau) - Top card always available for play.

Options

AutoPlay

Play

12 cards are dealt to a pile called the Reserve. A 13th card is dealt above and to the right of the
Reserve. This becomes the first of 4 Foundation piles. As cards of the same rank appear, they will
be moved to the other 3 Foundation piles. (ie. if the first Foundation pile started with a 5, the other
three 5's will be moved to the other Foundation piles as they appear). The Foundation piles will be
built up in suit, wrapping around from King to Ace as necessary. Below the Foundations, 3 cards
are dealt out to form 3 Tableau piles. The Tableau piles are built down regardless of suit, wrapping

around from Ace to King as necessary. For example, in the Tableaus a any 8 could be played on a
9. Entire Tableau piles can be moved onto other Tableau piles, if possible.

The remainder of the deck is placed face-down in the Stock. Stock cards are played (by clicking on
the Stock) one at a time to the waste pile. The top card of the wastepile is available for play on the
Tableaus or Foundations. Empty spaces in the tableau are filled from the reserve, or when the
reserve is empty from the wastepile.

There is no redeal.

History

Chameleon is a variation of Canfield.



Duke

1 Deck.

Object

To move all the cards to the Foundations.

Layout

e 4 Foundation piles (top right) - build up in suit from Aces to Kings.

e 4 Tableau piles (below foundations) - build down by alternate color. Move groups of cards if
they are in sequence. Spaces are filled from the Reserve if possible, then by any card.

e Stock (top left, face down) - turn over 1 card at a time, by clicking. Two redeals.

e Waste (next to Stock) - Top card always available for play.

e 4 Reserve piles (left of Tableau) - 3 cards in each pile, top card of each pile always available for
play.

Options

AutoPlay

Play

12 cards are dealt to 4 Reserve piles (3 cards per pile). Only the top card of each Reserve pile is
available. Then 4 cards are dealt to 4 Tableau piles. The Tableau piles are built down by alternate
colors, as in Canfield. As Aces become available, they are moved above the Tableau piles to form
the 4 foundation piles. The Foundation piles are built up in suit from Ace to King. The game is won
if all the cards are moved to the Foundations.

The remainder of the cards are placed face down in the Stock. The Stock is turned over 1 card at a
time to the wastepile. The top card of the wastepile is always available for play on the Foundations
or Tableau. Fill spaces in the Tableau from the Reserve piles, or, when the Reserves are empty,
from the wastepile. Multiple cards may be moved as a unit within the Tableau piles. There are two
redeals. To redeal, click on the empty Stock.

History

Duke is a variation of Canfield.



Storehouse
1 Deck.

Object

To move all the cards to the Foundations.

Layout
e 4 Foundation piles (top right) - build up in suit from Twos up to Aces.

e 4 Tableau piles (below foundations) - build down by suit. Move groups of cards if they are in
sequence. Spaces are filled from the Storehouse if possible, then by any card.

e Stock (top left, face down) - turn over 1 card at a time, by clicking. Two redeals.
e Waste (next to Stock) - Top card always available for play.

e Storehouse (left of Tableau) - Top card always available for play.

Options

AutoPlay

Play

The 4 twos in the deck are removed and put in a row. These are the 4 Foundation piles. 13 cards
are dealt in a pile below the Foundations, called the Storehouse. A row of 4 cards are dealt below the
Foundations. These are the 4 Tableau piles. The remainder of the deck is dealt face down to the
Stock, with the top card of the Stock turned over for the waste pile.

The Foundation piles are built up by suit, wrapping around Ace on top of King.  The Tableau piles
are built down by suit. Spaces created in the Tableau are immediately filled by the top card of the
Storehouse. The top cards of the Storehouse, Tableau piles, and wastepile are always available for
play on the Tableau or Foundations.

Turn over cards in the stock one at a time by clicking on the Stock. Two redeals are allowed.

History
Storehouse is a variation of Canfield.



2 Deck games

Busy Aces
Deuces

Threes Company
Fours Up

Sixes and Sevens
Congress

Frog

German Patience
Interregnum
Kings

Red and Black
Seven Devils

St. Helena



Busy Aces

2 Decks.

Object

To move all the cards to the Foundations.

Layout
e 8 Foundation piles (across top) - build up in suit from Ace to King.

e 12 Tableau piles (below Foundations on right) - build down in suit. Only top card available for
play. Empty piles can be filled by any card.

e Stock (below Foundations, face down on left) - move 1 card to Waste by clicking. No redeal.
e Waste (below Stock) - top card available for play.

Options

AutoPla

Play

The eight foundations are across the top of the screen (with the X's). To win the game, build the 8
foundations up in suit from Ace to King.

Below the foundations on the right are 12 Tableau piles. On the left (face down) is the Stock and
below that is the discard pile (Waste). To play, turn over cards from the Stock one by one to the
discard pile by clicking on the face-down Stock. The top card of the discard pile is always available
for play. The top card may be moved from the discard pile to a Tableau pile by dragging. The
tableau piles are built down by suit. For example, a six of diamonds can go on top of a seven of
diamonds. Cards can be played from one Tableau pile to another, if possible. Play Aces
immediately to the foundations, as well as any other cards that are possible. There is no reason to
not play cards to the foundation.

When all 8 foundations are filled, the game is won.

Note: The AutoPlay feature will automatically play cards to the foundation, if possible. This is a big
time saving feature in this game. However, you should be aware that there are situations where
there are two possibililities for play on the foundations, since there are two decks. There may be
two eights of Spades, for example, that could be played on a certain foundation. The AutoPlay
function may not move the same eight to this spot that you might.

History
Busy Aces is the first game of a family that includes Deuces, Three's Company, and Fours Up. ltis
the easiest to win of the family. Busy Aces is also known as Courtyard.



Deuces
2 Decks.

Object

To move all the cards to the Foundations.

Layout
e 8 Foundation piles (in box in middle) - build up in suit from Deuces to King to Ace.

e 10 Tableau piles (in a ring around the Foundations) - build down in suit. Only top card available
for play. Empty piles can be filled by any card.

e Stock (top left, face down) - move 1 card to Waste by clicking. No redeal.
e Waste (below Stock) - top card available for play.

Options

AutoPla

Play

At the beginning of the game, the eight 2's (the Deuces) are removed from the deck and placed in
the middle of the screen, inside the box. These are the 8 Foundation piles. They are to be built up
in suit, with Aces as the highest card, above the Kings. Ten cards are dealt around the foundation
box. These are the 10 Tableau piles. The Tableaus are built down in suit (for example, a 4 of
diamonds is played on a 5 of diamonds). The remaining cards in the deck are dealt to the Stock,
and the first card in the Stock is turned over to form the Waste pile. The top of the Waste pile is
always available for play on the Tableau or Foundations. The top card of each Tableau pile is
always available for play on another Tableau pile or the Foundations.

Cards are turned up from the Stock to the Waste one at a time by clicking on the Stock. The game
is won if all 104 cards can be played to the foundations.

History

Deuces is a game in the Busy Aces family. Deuces is slightly harder to win than Busy Aces.
Although in the beginning the first card in each foundation is already played for you (unlike Busy
Aces, where you must wait for all the aces to come out), because there are only 10 tableau piles
rather than the 12 of Busy Aces, it is harder to win.



Threes Company
2 Decks.

Object

To move all the cards to the Foundations.

Layout

e 8 Foundation piles (across top) - build up in suit from Threes to King, Ace, Two.

e 8 Tableau piles (below Foundations) - build down in suit. Groups of cards may be moved.
Empty piles can be filled by any card.

e Stock (bottom, face down on left) - move 1 card to Waste by clicking. No redeal.

e Waste (beside Stock) - top card available for play.

Options

AutoPlay

Play

The eight 3's are removed and placed in 8 piles at the top of the screen. These are the

Foundations. The Foundations are built up in suit, from the 3's up to King, then Ace, then 2. The
game is won if all the cards are moved to the Foundations.

Eight cards are dealt to 8 piles below the Foundations to form the Tableau. The Tableau piles are
built down in suit. The top card of any Tableau pile may be moved to the Foundations or another
Tableau pile. In addition, any group of cards can be moved from one Tableau pile to another.
Spaces in the Tableau can be filled by any card.

The remainder of the cards are placed face down in the Stock (at the bottom left). The Stock is
turned over 1 card at a time to the wastepile. The top card of the wastepile is always available for
play on the Foundations or Tableaus. There is no redeal.

History

Three's Company is more difficult to win than Deuces or Busy Aces. Although multiple card moves
are allowed in the tableau, there are fewer tableaus (8 compared to 10 for Deuces). Three's
Company was invented by the author of Pretty Good Solitaire, Tom Warfield.



Fours Up

2 Decks.

Object

To move all the cards to the Foundations.

Layout

e 8 Foundation piles (in box at right) - build up in suit from Fours to King, Ace, Two, Three.

e 6 Tableau piles (across top, left) - build down regardless of suit. Groups of cards may be moved
if they are in a descending sequence of the same suit. Empty piles can be filled by any card.

e Stock (bottom, face down on left) - move 1 card to Waste by clicking. No redeal.

e Waste (beside Stock) - top card available for play.

Options

AutoPlay

Play

The eight 4's are removed and placed in 8 piles in the box at the right. These are the Foundations.

The Foundations are built up in suit, from the 4's up to King, then Ace, 2, 3. The game is won if all
the cards are moved to the Foundations.

Six cards are dealt to 6 piles across the top of the screen to form the Tableau. The Tableau piles are
built down regardless of suit.. The top card of any Tableau pile may be moved to the Foundations or
another Tableau pile. In addition, any group of cards in a descending sequence by suit can be
moved from one Tableau pile to another. Spaces in the Tableau can be filled by any card or legal
group of cards.

The remainder of the cards are placed face down in the Stock (at the bottom left). The Stock is
turned over 1 card at a time to the wastepile. The top card of the wastepile is always available for
play on the Foundations or Tableaus. There is no redeal.

History

Fours Up is the most difficult to win of the Busy Aces family. Fours Up was invented by the author of
Pretty Good Solitaire, Tom Warfield.



Sixes and Sevens
2 Decks.

Object

To move all cards to the Foundations.

Layout

e 16 Foundation piles (on left) - build piles starting with Sixes down by suit to Aces, build piles
starting with Sevens up in suit to Kings.

e 9 Tableau piles (on right) - each pile can contain 1 card. No building.

e Stock (bottom right, face down) - turn over 1 card to Waste by clicking. No redeals.
e Waste (bottom right, next to Stock) - top card available for play.

Options

AutoPlay

Play

The Sixes and Sevens are removed from the deck to form 16 Foundation piles. The Sixes are built
down in suit to Aces and the Sevens are build up in suit to Kings. The game is won if all cards are
moved to the Foundations.

Nine cards are dealt to the Tableau. Each Tableau pile can contain 1 card. Cards in the Tableau
are moved to the Foundations, if possible. Spaces in the Tableau are filled from the Waste. The
rest of the cards are dealt to the Stock, which is turned over 1 card at a time to the Waste by clicking.
There are no redeals.

History
This game is easy to win. It is related to the Busy Aces family.



Congress
2 Decks.

Object

To move all cards to the Foundations.

Layout
e 8 Foundation piles (in center box) - build up in suit from Ace to King.

e 8 Tableau piles (to left and right of Foundations) - build down regardless of suit. Spaces are
filled from the Waste.

e  Stock (upper left, face down) - 1 card at a time moved to the Waste by clicking. No redeal.
e Waste (next to stock) - top card available for play.

Options

AutoPla

Play

1 card each are dealt to 8 Tableau piles. The Tableau piles are built down regardless of suit, with
spaces filled from the Waste. Only the top card of each Tableau pile is available for play. Move
Aces as the become available to the Foundations. The Foundations are built up in suit from Ace to
King. The game is won when all cards are moved to the Foundations.

Turn over cards from the Stock to the Waste by clicking. The top card of the Waste pile is available
for play on the Tableau or Foundations. There is no redeal.

History
Congress is related to Forty Thieves. Do not move cards to the Foundations unnecessarily; they
may be needed for lower cards in the Tableau.



Frog

2 Decks.

Object

To move all cards to the Foundations.

Layout

e 8 Foundation piles (across top) - build up in suit from Ace to King.

e Reserve (left, below Foundations) - begins with 13 cards - top card is available for play on the
Foundations.

e Stock (face down, next to Reserve) - turn over cards 1 at a time to main wastepile. No redeal.

¢ Main wastepile (below Stock) - top card is available for play. Can hold only 1 card at a time.

e 5regular Waste piles (right of Stock) - can contain any cards.

Options

AutoPlay

Play

13 cards are dealt to the Reserve. Any Aces are moved to the Foundations, which are built up in
suit from Ace to King. If no Ace turns up in the Reserve, an Ace is removed from the Stock and
placed on the first Foundation. The top card of the Reserve is available for play on the Foundations.
Move all other Aces, as they become available, to the Foundations. The game is won when all
cards are moved to the Foundations.

Turn over cards 1 at a time from the Stock by clicking. Cards are moved to the main wastepile,
below the Stock. From the main wastepile, move cards to the Foundations, if possible, or to any of
5 Waste piles. The top card of each Waste pile is available for play on the Foundations. There is
no redeal.

History
This game is also known as Toad. On the wastepiles, you should try to build downward, if possible.

One pile should be reserved for Kings and Queens. Don't put lots of cards of the same rank in the
same pile.



German Patience
2 Decks.

Object

To create 8 piles in ascending sequence of 13 cards, regardless of suit.

Layout

e 8 Tableau piles (across top) - build up regardless of suit, wrapping from Kings to Aces. Only the
top card may be moved.

e Stock (face down, bottom left) - turns over 1 card to the Waste by clicking. No redeal.

e Waste (next to Stock) - top card is available for play.

Play

8 cards are dealt to the Tableau piles. Your goal is to turn these 8 piles into 8 piles in ascending
sequence of 13 cards, regardless of suit, wrapping Kings to Aces. For example, a pile starting with
a Seven will be built up Eight, Nine, and so on wrapping around to Six. Begin by moving all cards
that are possible ascending regardless of suit.  Then turn over cards one by one from the Stock to
the Waste pile and play, if possible, on the Tableau. Only the top card of each Tableau pile may be
moved.

History

German Patience is a unique and very difficult game.



Interregnum
2 Decks.

Object

To move all cards to the Foundations.

Layout
e 8 Foundation piles (center row) - build up regardless of suit from the starting card to contain 13
cards, wrapping from King to Ace as necessary.

e 8 Indicator cards (top row) - indicate the top card for each Foundation. Must be the last card
played to the Foundation below it.

e 8 Tableau piles (bottom row) - top card available for play on the Foundations.
e Stock (bottom left) - deals 1 card to each Tableau pile by clicking.

Play

8 cards are dealt to the indicator row. This row indicates what the bases of the Foundations piles
will be. The card in the indicator row is the last card that will be played on the Foundation pile below
it. If the indicator card is a Five, for example, then the Foundation pile below it must start with a Six.
The Foundation piles are built up regardless of suit, wrapping from King to Ace as necessary until the
pile contains 13 cards. The indicator card will be moved to the Foundation automatically.

The top card of each Tableau pile (bottom row) is available for play on the Foundations. When all
play has come to a standstill, deal a row of 1 card to each Tableau pile by clicking on the Stock
(bottom left). The game is won if all cards can be moved to the Foundations, lost otherwise.

History
Interregnum is a rather unique game. | suggest using double-clicking to move the cards to the
Foundations, although note that this will always move the card to the leftmost possible Foundation.



Kings

2 Decks.

Object

To move all cards to the Foundations.

Layout

e 8 Foundation piles (across top) - build up from Ace to King regardless of suit.

e 8 Tableau piles (below Foundations) - build up or down, regardless of suit. Top card is available
for play. Spaces filled by any card.

Options

AutoPlay

Play

The 8 Aces are removed from the deck to form the 8 Foundations, which will be built up regardless of
suit to Kings. The rest of the deck is then dealt to the tableau, with this proviso: if the card can be
played to the Foundation directly above it, it will be. Hence many of the Foundations will already
have several cards in them at the beginning of the game.

Once all the cards are dealt, the Tableau piles are built either up or down regardless of suit. The top
card of each Tableau pile is available for play on other Tableau piles or the any of the Foundations.
Spaces in the Tableau may be filled by any card.

History
This game is of German origin.



Rouge et Noir
2 Decks.

Object

To move all the cards to the Foundations.

Layout

e 8 Foundation piles (across top) - build left 4 piles up in color from Ace to King (2 leftmost with X's
start with red Aces, next 2 with O's with black Aces), drop 13 card sequences of alternating color
from the Tableau on the right 4 piles (2 starting with X's with red Kings, 2 rightmost with O's with
black Kings).

e 10 Tableau piles (below Foundations) - build down in alternate color. Groups of cards in
descending opposite color may be moved as a unit. Spaces are filled only by Kings or legal
groups of cards with a King on the bottom.

e Stock (top left, face down) - deal 1 card to each Tableau pile by clicking.

Play

45 cards are dealt to the Tableau, 9 cards in the first pile, 8 in the 2nd, and so on. The 10th pile
starts empty. The Tableau is build down in alternate colors. Groups of cards in descending
opposite color may be moved as a unit. Spaces are filled only by Kings or legal groups of cards with
a King at the bottom.

The first 4 Foundations are built up in color from Ace to King, the left 2 with X's start with red Aces,
the 2nd 2 with O's start with Black Aces. You may move the top card of any Tableau pile to these
Foundations, but you may not necessary want to move available cards when they become available.
There is no AutoPlay in this game, so all cards must be moved by dragging or double-clicking on the
card.

The last 4 Foundations are built in the Tableau. Build 4 13-card sequences of alternate color, from
King down to Ace. To move these cards to the Foundations, pick up the entire 13-card sequence
and drop it on the desired Foundation pile. The left 2 piles with X's are for 13-card sequences
starting with a red King, the right 2 piles with O's for 13-card sequences starting with a black King.
Single cards are not allowed in these Foundation piles.

When all possible moves have been played, clicking on the Stock will deal 1 card to each Tableau
pile.

History

Rouge et Noir was invented by Charles Jewell. It is the most complicated, fascinating, and
strategically interesting game in this collection. Keep in mind at all times that you are not only trying
to build on the left 4 Foundations up in color, but also you must build 4 complete 13-card sequences
in opposite color, sort of like they are built in Spider. Whether to move a card to the 4 left
Foundations or to keep it in the Tableau for building one of the sequences is a choice you are faced
with often. Also, note that when a new row of cards is dealt from the stock, you are likely to have
many cards buried.






Seven Devils
2 Decks.

Object

To move all cards to the Foundations.

Layout
e 8 Foundation piles (across top) - build up in suit from Ace to King.
e Reserve (left, under Foundation) - top card is available for play only on the Foundations.

e 7 Tableau piles (below Foundations) - build down by opposite colors. Only one card at a time
may be moved. Spaces filled by any card not from the Reserve.
e  Stock (bottom left) - turn over 1 card to Waste by clicking. No redeal.

e Waste (next to Stock) - Top card is available for play.
Options
AutoPlay

Play

There are 8 Foundation piles that will be built up in suit from Ace to King. The game is won if all the
cards are moved to the Foundations. 28 cards are dealt to the Tableau as in Klondike. Seven
cards are dealt to the Reserve to the left of the Tableau. These are the Seven Devils, and they can
only be played to the Foundations. The Tableau piles are built down by opposite color. Only one
card at a time may be moved between Tableau piles. Spaces in the Tableau can be filled by any
card except those in the Reserve.

Turn over cards 1 at a time from the Stock to the Waste by clicking. The top card of the Waste is
available for play on the Tableau or Foundations. There is no redeal.

History

Seven Devils is a 2 pack cross between Klondike and Canfield. The fact that the Seven Devils can
only be moved to the Foundations makes this game difficult.



St. Helena

2 Decks.

Object

To move all cards to the Foundations.

Layout

e 8 Foundation piles (in center box) - build 4 down by suit from King to Ace and 4 up by suit from
Ace to King.

e 12 Tableau piles (around Foundations) - build up or down regardless of suit (no wraparound).
Empty piles are not filled.

¢ Redeal indicator (top left) - click to redeal the cards. There are two redeals. (Redeals in this
game cannot be Undone).

Play

First, one Ace and one King from each suit are removed from the deck and placed in the middle of
the screen. These form the beginnings of 8 foundations, 4 "King-foundations" and 4 "Ace-
foundations".  The remaining 96 cards are dealt into 12 tableau piles circling the foundations. Four
piles are placed above the King-foundations, 4 piles below the Ace-foundations, and 2 on each side
of the foundations.

The objective is to build the King-foundations down in suit to aces, and the Ace-foundations up in suit
to Kings. When all the cards are in the foundations, the game is won.

The top card of each Tableau pile is always available for play on the Foundations, with one
exception: until the first redeal, cards from the piles above the King-foundations can only be played
to the King-foundations, and cards from the piles below the Ace-foundations can only be played to
the Ace-foundations. Cards from the sides can be played anywhere, and after the first redeal, cards
from any Tableau pile can be played to any Foundation.

TheTableaus are built up or down in sequence, regardless of suit. The top card of any Tableau can
be so moved to any other Tableau. For example, a 9 can be played on an 8, as cana 7. However,
only a Queen can be played on a King, and only a 2 can be played on an Ace. An empty Tableau
pile cannot be filled.

Two redeals are allowed. In aredeal the cards are not shuffled. Rather, each tableau pile is picked
up in counter-clockwise order, and then the cards are dealt back to each pile clockwise. You cannot
undo a redeal.

History
St. Helena is a classic solitaire game known by many other names, such as Napoleon's Favorite or
Washington's Favorite.






800 x 600 games

Seahaven Towers

Forty Thieves
Gargantua
King Albert
Rouge et Noir
Simple Simon
Spider
Terrace
Windmill



Seahaven Towers
1 Deck.

Object

To move all the cards to the Foundations.

Layout
e 4 Foundation piles (top, 2 on far left, 2 on far right) - build up in suit from Ace to King.
e 4 Cells (top center) - storage location for one card.

e 10 Tableau piles (below Foundations and Cells) - build down by suit. Move groups of cards if
they are descending by suit and if there are enough open cells. Fill spaces with Kings.

Options

AutoPlay

KingOnly

Play

5 cards are dealt to each tableau pile, with 2 cards dealt to the Cells. Build the Foundations up in
suit from Ace to King. The game is won when all cards are moved to the Foundations. In the
Tableau, build down in suit. Groups of cards in descending sequence by suit may be moved as a
unit, but only if there are enough empty cells or Tableau piles for the cards to be moved individually.

Spaces in the Tableau can be filled only by Kings, unless the KingOnly option is not set. The 4 cells
can hold any cards, but only one card at a time.

The game is played by building on the Tableau and moving cards to the Foundations as they become
available. Use the Cells to store cards that get in the way of building on the Tableau.

History
Seahaven Towers is very similar to FreeCell.

The differences are: in Seahaven Towers there are 10 tableau piles instead of 8, and in Seahaven
Towers the tableaus are built down in suit, rather than by opposite color. Therefore, a 8 of spades
can only have a 7 of spades played on it. Also, the cells are in the middle of the screen at the top,
and the foundations are split up on the two sides.



Forty Thieves

2 Decks.

Object

To move all the cards to the Foundations.

Layout

¢ 8 Foundation piles (across top, with X's) - build up in suit from Ace to King.

e 10 Tableau piles (below Foundations) - build down in suit. Spaces may be filled by any card.
e Stock (top left, face down) - turn over 1 card at a time to the Waste by clicking. No redeal.

e Waste (next to Stock) - top card is available for play.

Options

AutoPlay

Play

Forty cards are dealt to 10 tableaus, 4 cards to a tableau. Above the tableaus are 8 foundation

piles. Move Aces to the Foundations as they become available. The foundation piles will be built
up in suit from Ace to King.  The game is won if all the cards are moved to the foundations.

The remainder of the cards form the stock (upper left corner). The stock is turned over 1 card at a
time to the waste pile. The top card of the waste pile is always available for play on the foundations
or tableau. The tableau piles are built down in suit. The top card of a tableau pile can be moved to
the foundations or to another tableau pile. Only one card at a time can be moved in the tableau. A
space in the tableau can be filled by any card. There is no redeal.

History

This is a classic solitaire game that probably dates back to the nineteenth century. It is known by
many names, such as Napoleon at St. Helena, Big Forty, Roosevelt at San Juan, and Le Cadran. It
has many variations, most of which are easier to win, since this game is very challenging. Because
there are so many possible variations of this game, there is another Windows solitaire program
devoted to it.

Napoleon Solitaire
Tips: Try to get a space in the tableau as quickly as possible. This game is difficult to win.



Napoleon Solitaire

Napoleon Solitaire is a collection of Windows solitaire games based on the game Forty Thieves. It
contains Forty Thieves and 10 other variations on Forty Thieves, such as Rank and File, Indian,
Number Ten, and more. It also contains a Game Wizard that allows the user to create his or her
own solitaire games by changing the rules. Up to 900 different solitaire games can be created.
Look for Napoleon Solitaire in the same place you found Pretty Good Solitaire, or download it from
the World Wide Web at http://users.aol.com/GoodSol/napsol.html.

Napoleon Solitaire 1.0

by Tom Warfield

released January 1996

Registration price: $15
http://users.aol.com/GoodSol/napsol.html



Gargantua
2 Decks.

Object

To move all the cards to the Foundations.

Layout

e 8 Foundation piles (across top) - build up in suit from Ace to King.

e 9 Tableau piles (below Foundations) - build down by alternate color. Groups of cards in
descending alternating colors may be moved. Spaces are filled only by Kings or groups with a
King at the bottom.

e Stock (bottom left, face down) - turn over 1 card to the Waste by clicking. One redeal.

e Waste (next to Stock) - top card available for play.

Options

AutoPlay

KingOnly

Play

45 cards are dealt to the tableau, 1 in the first pile, 2 in the 2nd, and so on. The top card is face up.
The rest of the cards form the Stock. Move Aces as they become available to the Foundations,
which are built up in suit from Ace to King. The game is won if all the cards are moved to the
Foundations. The Tableau is build down in alternate colors. Groups of cards in descending

opposite colors may be moved. Spaces in the Tableau are filled only by Kings or groups of cards
with a King on the bottom, unless the KingOnly option is not set.

Turn over cards 1 at a time from the Stock to the Waste by clicking. The top card of the Waste pile
is always available for play. There is one redeal.

History

Gargantua is a 2 deck version of Klondike. It was invented by Albert H. Morehead and Geoffrey
Mott-Smith.



King Albert

1 Deck.

Object

To move all the cards to the Foundations.

Layout
e 4 Foundation piles (across top) - build up in suit from Ace to King.

e 9 Tableau piles (below Foundations) - build down by alternate color. Only the top card of each
pile may be moved. Spaces may be filled by any available card.

e 7 Reserve cards (across bottom) - each card is available for play on the Foundations or Tableau.
Options

AutoPlay

Play

45 cards are dealt to the Tableau, 1 in the first pile, 2 in the 2nd, and so on. The top card is face up.
The seven remaining cards form the Reserve, at the bottom of the screen. Move Aces as they
become available to the Foundations, which are built up in suit from Ace to King. The game is won
if all the cards are moved to the Foundations. The Tableau is build down in alternate colors. Only
the top card of each Tableau pile may be moved. Spaces in the Tableau are filled by any available
card. Each card in the Reserve is available for play on the Tableau or Foundations.

History
This game is also known as Idiot's Delight.



Simple Simon
1 Deck.

Object

To create 4 13-card sequences descending in suit from King to Ace.

Layout

e 10 Tableau piles - build down regardless of suit. Groups of cards in descending sequence by
suit may be moved as a unit. Spaces are filled by any card.

Play

The entire deck is dealt face up to the 10 Tableau piles. The Tableau piles are built down
regardless of suit. Groups of cards in descending sequence by suit may be moved as a unit.
Spaces are filled by any card. The objective is to build 4 13-card sequences descending in suit from
King to Ace. If this is done, and the Tableau consists of 4 piles of such sequences, then the game is
won.

History

Simple Simon bears some resemblance to Scorpion.



Spider

2 Decks.

Object

To group all the cards in sets of 13 cards in descending sequence by suit from King to Ace.

Layout

e 10 Tableau piles - build down regardless of suit. Groups of cards in descending sequence by
suit may be moved as a unit. A space can be filled by any card or legal group of cards.

e Stock (top left, face down) - deals 1 card to each Tableau pile by clicking.

Play

54 cards are dealt in 10 piles, 6 cards to the first 4 piles, and 5 cards to the remaining piles. Only
the top card of each pile is face up. The rest of the cards (50 of them) form the stock (at the upper
left).

The 10 piles are both tableau and foundation piles. The top card of each pile is always available.
Cards are built down, regardless of suit. However, building down by suit is preferred. Cards may
be moved as a unit if they are in a proper downward sequence and are all of the same suit (groups of
cards not of the same suit cannot be moved). When all cards above a facedown card are moved,
the card is turned face up. A space made can be filled by any card or legal group of cards.

The objective is to group all the cards in sets of 13 cards, from King to Ace of the same suit.
Whenever such a group is formed in a pile, it is removed from play. The game is won if all 8 sets
can be removed from play.

Whenever play has come to a standsitill, click on the stock. 1 card will be dealt on the top of each
tableau pile. All piles must have at least one card in them before you can do this. When the stock
is empty and you are unable to form the tableaus into sets of 13 cards of each suit, the game is lost.

History
Spider is one of the classic solitaire games. Tips: Try to build in suit if possible. Spaces should be
made as soon as possible, and used to move cards into groups by suit.



Terrace
2 Decks.

Object

To move all the cards to the Foundations.

Layout
e 8 Foundation piles (with X's) - build up in suit, wrapping from King to Ace as necessary.

e 9 Tableau piles (below Foundations) - build down by alternate color. Only the top card of each
pile may be moved. Spaces may be filled by any available card not from the Reserve.

¢ Reserve (top) - each card is available for play on the Foundations only.

e Stock (top left, face down) - turn over cards 1 at a time to the Waste by clicking. No redeal.
e Waste (next to Stock) - top card is available for play.

Options

AutoPlay

Play

Eleven cards are dealt to the Reserve. Below the Reserve are the 8 Foundation piles, which are
built up in suit, wrapping from King to Ace as necessary. The game is won when all cards have
been moved to the Foundations. Cards in the Reserve may only be played to the Foundations.
Below the Foundations is the Tableau. Tableau piles are built down by opposite colors. Only the
top card of each Tableau pile may be moved. Spaces may be filled by any available card not from
the Reserve.

At the beginning of the game 4 cards are dealt to the Tableau. Select one of the 4 cards and play it
to the first Foundation pile. This marks the base card from which all the Foundations will be built.
For example, if you play a Seven to the first Foundation pile, all the other Foundations will start with
Sevens. After the card is moved to the first Foundation pile, the rest of the Tableau will be dealt.

Turn over cards 1 at a time from the Stock to the Waste by clicking on the face down Stock. The top
card of the Waste is available for play. There is no redeal, although when the Stock is depleted the
Waste may be turned over, and cards can then be played to the Tableau or Foundations if possible.

History

The restriction on play of cards in the Reserve makes this game difficult. Note that it is extremely
important which card you begin the game with by moving it to the first Foundation pile. Examine the
Reserve closely to make the best choice. If there are several Sixes in the Reserve, for example,
you wouldn't want to pick a Six, or even a Five or Four as your Foundation base.



Windmill

2 Decks.

Object

To move all the cards to the Foundations.

Layout

e 5 Foundation piles (1 in center, 4 others diagonally around it, with X's) - build the center
Foundation, which begins with an Ace, up regardless in suit, wrapping from King to Ace as
necessary, until it contains 52 cards. Build the other 4 Foundations down regardless of suit from
Kings to Aces.

e 8 Tableau piles (extending in all 4 directions from the center Foundation) - each pile may contain
1 card. Spaces are filled immediately from the Waste or Stock.

e Stock (top left, face down) - turn over 1 card at a time by clicking. No redeal.
e Waste (next to Stock) - the top card is available for play.

Options

AutoPlay

Play

An Ace is dealt to the center Foundation. This foundation will be built up regardless of suit,
wrapping from King to Ace as necessary, until it contains 52 cards. The 4 other Foundation piles
around it diagonally (with X's) are to be built down regardless of suit from Kings to Aces. The game
is won if all cards are moved to the Foundations. The 8 Tableau piles (or "sails") can only contain 1
card. Spaces are filled immediately from the Waste or Stock.

Move Kings as they become available to the Foundations. Turn over the Stock to the Waste one
card at a time by clicking on the face down Stock. There is no redeal.

History

Windmill is also known as Propeller. Feed the big center pile every time you can.
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Golf

1 Deck.

Object

To move all the cards to the Waste pile.

Layout

e 7 Tableau piles (across top) - no building. Top card of each pile is available for play on the
Waste pile.

e Stock (face down below Tableau) - turn over 1 card to the Waste by clicking.

e Waste (next to stock) - build up or down in sequence regardless of suit. No wraparound, only
Twos can be played on Aces and nothing can be played on a King.

Play

Seven piles of 5 cards each are dealt face up, forming theTableau. One more card is dealt face up
to become the Waste pile. The rest of the cards are dealt face down in the Stock pile.

Only the top card of each pile is available. To play, build in sequence either up or down regardless

of suit on the waste pile. For example, if the top of the waste pile is a 5, you can play either a 6 or a
4 onit. The sequences do not "wrap around." Only a 2 can be played on an ace, and nothing can
be played on a king.

Whenever there are no possible plays, turn over a card in the Stock by clicking on it. This card goes
to the Waste pile.

The game is won if the Tableau is cleared. If the tableau is not cleared, the object is to leave as few
cards as possible.

History
Golf is a very simple game to play, but difficult to win. Work out your sequences in advance. Be
careful to save queens for kings, and twos for aces.



Auld Lang Syne

1 Deck.

Object

To move all the cards to the Foundations.

Layout
e 4 Foundation piles (top) - build up from Ace to King regardless of suit.

e 4 Reserve piles (below Foundations) - cards are dealt here from the Stock. The top card of
each pile is available for play. Move cards to the Foundations by clicking.

e Stock (face down) - deal 1 card to each Reserve pile by clicking. No redeal.

Play

The 4 Aces are removed from the deck and placed across the top to form the 4 Foundations. These
will be built up regardless of suit to Kings. The object is to move all of the cards to the Foundations.

Below the Foundations 4 cards are dealt to begin 4 Reserve piles. Only the top card of each pile is
available for play on the Foundations. Move cards to the Foundations by clicking on the card in the
Reserve. When all possible moves have been played, deal another row of cards on the Reserves
by clicking on the face down Stock. There is no redeal.

History

This is an old and classic solitaire game. It is also known as Patience. It is difficult to win and
involves no skill. Sir Tommy is a variation of this game that is easier to win and involves some skill.



Black Hole

1 Deck.

Object

To move all the cards to the center pile, the Black Hole.

Layout

e Black Hole (center pile) - begins with the Ace of Spades, build up or down regardless of suit, with
Ace and King considered consecutive.

e 17 Fans of 3 Cards each - the top card is available for play to the Black Hole.

Play

The Black Hole (the pile in the center starting with the Ace of Spades) is built up or down regardless
of suit, wrapping around from King to Ace or Ace to King. The object is to move all 52 cards to the
Black Hole.

History
Black Hole was invented by David Parlett. It is easy to play, but requires a great deal of advance
calculation to win. Map out the cards you wish to play to the Black Hole before you play them.



5 Piles

1 Deck.

Object

To discard all the cards.

Layout
e 5 Piles (surprise!) - discard pairs of cards that add to 13, Kings singly. The top card of each pile
is available.

e Stock (far right, face down) - clicking deals 1 card to each of the 5 piles.

Play

The Stock is on the upper right of the screen. At the beginning of the game, 5 cards are dealt,
forming the 5 piles. Any pair of cards out of these 5 whose values add to 13 can be discarded. For
example, a 10 and a 3 form a pair. To discard them, drag one of the cards onto the other. Kings
are discarded singly. To discards Kings, simply click on them. When all possible pairs are
discarded, deal another set of 5 cards onto the piles by clicking on the Stock. The last 2 cards in the
deck form their own piles and can be discarded with cards from any of the 5 piles.

The game is won if all 52 cards are discarded. The game will inform you if you win, or if you have
no more possible moves.

History
5 Piles is an easy game to play, but fairly difficult to win. It is also known as Baroness.



Fortunes Favor
1 Deck.

Object

To move all the cards to the Foundations.

Layout
e 4 Foundations (across top with X's) - build up in suit from Ace to King.

e 12 Tableau piles (in box) - build down in suit. The top card of each pile is available for play.
Spaces are filled from the Waste or Stock.

e Stock (left, face down) - deal 1 card at a time to the Waste by clicking. No redeal.
e Waste (below Stock) - top card is available for play.

Options

AutoPla

Play

The four Aces are removed from the deck and form the 4 Foundation piles. These Foundations will
be built up in suit to Kings. The game is won if all the cards are moved to the Foundations.

Twelve cards are dealt to twelve piles to form the Tableau. The Tableau piles are built down in suit.
One card at a time may be moved from the Tableau to the Foundations or another Tableau. Spaces
in the Tableau are filled from the Waste or Stock. The rest of the deck goes face down in the Stock.
The Stock is turned over 1 card at a time (by clicking) to the Waste. The top card of the Waste is
always available for play on the Foundations or Tableau.

History
Fortune's Favor is a simple game related to Busy Aces, except it uses only 1 deck. This game is
easy to win.



Fourteen Out
1 Deck.

Object

To pair up all cards and move them to the waste pile.

Layout
e 12 Tableau piles - the top card of each pile is available. Pair cards that total to 14.
e Waste pile (bottom of screen) - where paired cards go out of play.

Play

The entire deck is dealt face up into 12 piles (8 piles of 4 cards, 4 piles of 5 cards). Only the top
card of each pile is available for play.

The object of the game is to discard all the cards in pairs that total to 14. For example, a king and
an ace, aqueen and a 2, oran 8 and a 6. To remove a pair, pick up one card with the mouse and
drop it on the other.

History

Fourteen Out is a simple game to play, and is fairly easy to win.

The game is won if the entire deck is discarded.



Nestor
1 Deck.

Object

To pair up all the cards and move them to the waste pile.

Layout

e 8 Tableau piles (across top) - the top card is available for play. Pair up cards of the same rank.
e 4 extra cards (below Tableau) - each card is available for play.

e Waste pile - Where paired cards go out of play.

Play

Six cards are dealt to Eight Tableau piles. The extra four cards are dealt singly below the Tableau.
The top card of each Tableau pile is available for play. Pair up cards of the same rank (ie. two
Queens, or two Fives). Pairs are removed from play and go to the waste pile. The objective is to
pair up the entire deck.

History
Nestor is a simple game to play, but it is not necessarily simple to win.



Perpetual Motion
1 Deck.

Object

To move all the cards to the waste pile.

Layout

e 4 Tableau piles (across top) - move cards of the same rank together. Only the top card of each
pile is available. When all 4 cards of the same rank are together, they are moved to the waste
pile.

e Stock (face down to the right of the Tableau) - deal one card to each Tableau pile by clicking.

e Waste pile - where cards go out of play.

Play

In Perpetual Motion, the entire deck is placed in the stock pile (at the far right of the screen). Four
cards are dealt to form 4 tableau piles. If any cards in the tableau have the same rank (such as, two
of the cards are Jacks), the rightmost of the pair is moved on top of the leftmost (pick up the right
card with the mouse and drop it on the left). (Note: the Rules option in the Options menu allows you
to choose between drag and drop and clicking. If clicking is set, instead of dragging the card you
want to move to the left, simply click on it.) Once all possible pairs have been doubled up in this
way, deal another row of 4 cards on top of the tableau by clicking on the face-down stock pile.

After all 52 cards in the deck have been dealt out and moved (if possible), click on the ReDeal
button. This starts a complicated process that puts all the cards once again back in the stock.
(note that the cards are not reshuffled, just picked up in a certain way).

Any time an entire row of 4 cards are of the same rank (4 Jacks, for example), click on one of the 4
cards. The 4 cards are then removed from play. The object of the game is to get the entire deck
removed from play.

History
Perpetual Motion is a very simple game. In fact, there is no strategy to it at all. But totally mindless
games have their uses.



Sir Tommy
1 Deck.

Object

To move all the cards to the Foundations.

Layout

e 4 Foundations (across top) - build up from Ace to King, regardless of suit.

e 4 Reserve piles (below Foundations) - cards are played here from the Stock. The top card of
each pile is available for play. Move cards to the Foundations by clicking.

e Stock (face down) - Top card is available for play on the Reserves or Foundation. No redeal.

Play

The 4 Aces are removed from the deck and placed across the top to form the 4 Foundations. These
will be built up regardless of suit to Kings. The object is to move all of the cards to the Foundations.

Below the Foundations 4 cards are dealt to begin 4 Reserve piles. Only the top card of each pile is
available for play on the Foundations. Move cards to the Foundations by clicking on the card in the
Reserve. Turn over cards one by one from the stock, and play them on the Foundations (if possible)
or on any Reserve pile. There is no redeal.

History

This is an old and classic solitaire game. It is closely related to Auld Lang Syne, but requires more
skill and is easier to win, and is also related to Strategy. The skill in this game is deciding which
Reserve pile to put each card in. You do not want to block yourself by putting higher cards on top of
lower cards, unless absolutely necessary.



Sultan of Turkey

2 Decks.

Object

To move all the cards to the Foundations.

Layout

e 9 Foundation piles (in center box) - build up in suit from King to Ace up to Queen, except for the
center King (the Sultan), which is not built on at all.

e 8 Reserve piles (around the Foundations) - can contain one card.

e Stock (face down) - turn over cards one at a time to the Waste pile by clicking. There are 2
redeals.

e Waste pile (next to stock) - The top card is available for play.
Options
AutoPlay

Play

The Eight Kings and one Ace are removed from the deck, and form the Foundation piles, which are
built up in suit from King to Ace up to Queen, except for the center King (the Sultan), which is not
built upon, and the Ace, which simply built up in suit to the Queen. When the game is over, the
Sultan will be surrounded by the eight Queens.

Turn cards over from the stock one by one, and play them to the Foundations (if possible) or to the
Reserve piles. Each Reserve pile can contain one card. Cards that can't be played remain in the
Waste pile. There are two redeals.

History

This is a very old game. It is easy to win and requires very little skill.



Miscellaneous games

FreeCell
Bakers Dozen

Beleaguered Castle
Bristol

Eagle Wing
Four Seasons
La Belle Lucie
Martha
Penguin

Pyramid
Shamrocks

Stalactites

Strategy
TetSol

Triangle



FreeCell

1 Deck.

Object

To move all the cards to the Foundations.

Layout

e 4 Foundation piles (top right) - build up in suit from Ace to King.

e 4 Cells (top left) - storage locations for cards. Only 1 card allowed in each cell.

e 8 Tableau piles (below foundations and cells) - build down by alternate color. Move groups of

cards if they are in sequence. Fill spaces with Kings or groups of cards with a King at the
bottom.

Options

KingOnly

AutoPlay

Play

The entire deck is dealt into 8 piles of cards, called the Tableau. Above the Tableau are 4 cells

(marked with X's), and 4 Foundation piles (to the right of the cells). The object of the game is to
build up the Foundation piles from Ace to King, one for each suit. The first cards that go on the

Foundation are the Aces, then a Two of the same suit can be placed on an Ace, and soon. The
game is won if all 52 cards are moved to the Foundation piles.

The top card of any Tableau pile can be moved to a Foundation pile, if possible. The top card of any
Tableau pile can also be moved to any cell. Only one card is allowed at a time in a cell. Cards in
the cells can be moved to the Foundation piles, if possible, or back to the Tableau, if possible.

Only the top card of any Tableau pile can be moved, unless there are enough empty cells or tableau
piles that a group of cards could be moved individually. In that case, the entire group can be moved
at once as a shortcut. Tableau piles are built down by alternating color. For example, a red 7 could

be played on a black 8.

History

FreeCell is closely related to Seahaven Towers. Penguin and Stalactites are also similar games.



Bakers Dozen
1 Deck.

Object

To move all the cards to the Foundations.

Layout
e 4 Foundation piles (right) - build up in suit from Ace to King.

e 13 Tableau piles (left of foundations) - build down by regardless of suit. Only one card at a time
may be moved. Spaces are not filled.

Options
AutoPlay
Play

The entire deck is dealt into 13 piles of 4 cards each. The 4 Kings are immediately moved to the
bottom of their piles. The top card of each pile is available for play.

The 4 piles at the right of the screen are the Foundation piles. The Foundation piles are built up in
suit from Ace to King. The game is won when all 52 cards are moved to the Foundation piles.

The 13 Tableau piles are built down regardless of suit. For example, a 7 of hearts could be played
on an 8 of diamonds. Only one card at a time may be moved. Any spaces left by removing an
entire pile cannot be filled.

History

This is a game of skill, related to Beleaguered Castle and Martha. Don't let one foundation get too
far ahead of the others. Watch for piles that contain a lower card of a suit below a higher card of the
same suit.



Beleaguered Castle
1 Deck.

Object

To move all the cards to the Foundations.

Layout

e 4 Foundation piles (middle) - build up in suit from Ace to King.

e 8 Tableau piles (around foundations) - build down regardless of suit. Only the top card of each
pile is available for play. Spaces may be filled by any available card.

Options

AutoPlay

Play

The 4 Aces are removed from the deck and placed in a column, becoming the Foundations. The
Foundations are built up in suit to Kings. The game is won if all the cards are moved to the
Foundations.

The rest of the deck is dealt face up into 8 Tableau piles of 6 cards each, 4 piles on either side of the
Foundations. On the Tableau, build down regardless of suit. For example, any 8 could be played
on any 9. Only the top card of each pile is available for play. A space created by moving all the
cards in a pile can be filled by any available card.

History
This is a game of skill, related to Baker's Dozen and Martha. Don't let one foundation get too far
ahead of the others. Try to create a space as quickly as possible.



Bristol
1 Deck.

Object

To move all the cards to the Foundations.

Layout
e 4 Foundation piles (top) - build up in suit from Ace to King.

e 8 Tableau piles (below foundations) - build down regardless of suit. Only the top card of each
pile is available for play. Spaces are not filled.

e Stock (face down) - Turn over cards 3 at a time, one to each Waste pile. There is no redeal.
e 3 Waste piles (to the right of the Stock) - The top card of each Waste pile is available for play.

Options
AutoPlay
Play

Three cards each are dealt to 8 Tableau piles, or "Fans". Kings are moved to the bottom of a Fan.
The object is to build the Foundation piles up in suit from Ace to King. The game is won when all
cards are moved to the Foundations.

The remainder of the deck forms the Stock. The stock is turned over 3 cards at a time, one to each
of 3 Waste piles. Only the top card of each Waste pile is available for play on the Foundations or
the Fans.

The Fans are built down regardless of suit. Only the top card of each Fan is available for play.
Spaces are not filled.

History
Bristol was invented by Albert Morehead and Geoffrey Mott-Smith.



Eagle Wing

1 Deck.

Object

To move all the cards to the Foundations.

Layout

e 4 Foundation piles (top, with X's) - build up in suit from the starting card to King, then Ace, until
each pile contains 13 cards.

e 8 Tableau piles (the wings) - build down in suit, limit of 3 cards per pile, wrapping from Ace to
King as necessary. Groups of cards may be moved. Spaces are filled from the Reserve (or
Trunk) until it is empty, then by any card.

e Reserve or Trunk (middle) - cards may be moved to the Tableau or Foundations.
e Stock (face down, bottom left) - turn over cards one at a time by clicking.
e Waste (next to Stock) - top card is available for play.

Options

AutoPlay

Play

Some number of cards (13, 15, 17, 19 or 21, depending on the setting in the Options menu) are dealt
face down into what is called the Trunk (in the box in the center of the screen). The top card of the

Trunk is turned face up. Then 8 cards are dealt face up into what are called the "wings". Finally,
one card is dealt face up on the Foundation (in the box at the top of the screen).

All cards of the same rank as the first Foundation card are played to the other spaces in the
Foundation as soon as they become available. The Foundations are built up in suit until they
contain 13 cards, Aces wrapping around on top of Kings. To play card on the Foundation, pick it up
and drop it on the Foundation with the mouse.

Any top card in the Wings can be played to the Foundation. Cards can be placed on other cards in
the Wings if they are of the same suit and one lower in rank. (For example, a 3 or hearts can be
played on a 4 of hearts). Kings wrap around on top of Aces. There is a limit of 3 cards in each
Wing. To play a card on the Wings, pick it up a drop it on the desired Wing with the mouse. Cards
can be moved from one Wing to another, if this is possible by the rules about suits and ranks, and if
the 3 card limit is not exceeded. Any open spaces in the Wings are automatically filled from the
trunk until the Trunk is empty. Then open spaces can be filled from the Stock, Waste, or other
Wings.

The remainder of the deck is placed in the stock at the bottom left of the screen. Click on the stock to
move the top card to the Waste. The top card of the Wastepile is always available for play on the
Wings or Foundation.

When the stock is empty, the Waste can be redealt by clicking on the empty Stock, assuming that a
redeal is allowed. The number of redeals is in the Options menu (none, 1, or 2).

The game is won if all 52 cards are placed on the Foundation.



History

Eagle Wing can be very easy or very difficult depending on the settings. A 13 card trunk with 2
redeals is fairly easy to win. A 21 card trunk with no redeals is very difficult to win. A happy
medium, with a 17 card deck and 1 or 2 redeals, is generally the best to play.



Four Seasons
1 Deck.

Object

To move all the cards to the Foundations.

Layout

e 4 Foundation piles (corners, with X's) - build up in suit from the starting card to King, then Ace,
until each pile contains 13 cards.

e 5 Tableau piles (forming cross) - build down regardless of suit, wrapping from Ace to King as
necessary. Spaces are filled by any card.

e Stock (face down) - turn over cards one at a time by clicking. No redeal.
e Waste (next to Stock) - top card is available for play.

Options
AutoPlay
Play

A Tableau of 5 cards in the shape of a cross are dealt. The 6th card is dealt in the top left corner of
the cross, becoming the first Foundation. The other 3 corners of the cross are the other
Foundations. The remainder of the deck forms the Stock (face down).

As the other 3 cards of the same rank as the first Foundation card become available, place them in
the other 3 corners. Build the Foundations up in rank by suit (with Aces going on top of Kings). For
example, a seven of spades goes on top of the six of spades.

Build the 5 Tableau piles down by rank regardless of suit (with Kings going on top of Aces). For
example, a 5 of hearts could be played on a six of clubs. The top card of each Tableau is always
available for play on any of the other Tableaus or theFfoundations. Fill any spaces in the Tableau
from any other Tableau pile, or the Stock.

Cards are turned up from the Stock one at a time (by clicking on the Stock) and can be played on
either the Tableau or Foundations. The top card of the Stock is always available for play.

There is no redeal of the stock.

The game is won if all cards are moved to the Foundation piles.

History

Four Seasons is relatively difficult to win; perhaps only 1 hand in ten can be won.



La Belle Lucie
1 Deck.

Object

To move all the cards to the Foundations.

Layout
e 4 Foundation piles (top, with X's) - build up in suit from Ace to King.

e 17 Fans (below Foundations) - build down in suit. Only one card at a time may be moved.
Spaces are not filled.

Options
AutoPlay
Play

The entire deck is dealt face up into 17 groups (called fans) of 3 cards, with 1 card left over. There
are 4 Foundation piles at the top of the screen. To win, build the Foundations up in suit from Ace to
King.

Only the top card of each fan is available for play. One card at a time can be moved from a fan to a
Foundation, or to another fan. The fans are built down in suit. For example, a 8 of spades can be
played on a 9 of spades. Spaces made by playing all the cards of a fan are not filled. There are
two ways to move cards between fans, depending on the settings under Rules in the Options menu.
If Drag and Drop is set, the cards are dragged with the mouse. If Click is set, clicking on a card in a
fan automatically moves it to the one other fan that it can move to.

There are two redeals. After all possible plays have been made, redeal by clicking on the O in the
upper left corner. All the cards in the fans are reshuffled. The Foundations remain. When the O
becomes an X, there are no more redeals.

You cannot undo a redeal.

History

This game is tough. Once you move a card onto a fan, the cards below are blocked until a redeal,
unless they can be played to a foundation. Kings block all cards below them as well. Play cards to
the foundation when they are available.



Martha

1 Deck.

Object

To move all the cards to the Foundations.

Layout
e 4 Foundation piles (right) - build up in suit from Ace to King.

e 12 Tableau piles (left of foundations) - build down by alternate color. Groups of cards of
descending opposite colors may be moved as a unit. Spaces are not filled. Spaces can be
filled by any single card (not a sequence).

Options
AutoPlay
Play

The 4 Aces are removed from the deck and start the 4 Foundation piles. One card each is dealt face
down to 12 Tableau piles. Then one card is dealt face up, then another face down, then one face
up.  The top card of each pile is available for play.

The Foundation piles are built up in suit from Ace to King. The game is won when all 52 cards are
moved to the Foundation piles.

The 12 Tableau piles are built down by alternate color. Groups of cards in descending alternate
color may be moved as a group. Spaces are filled by any single card (not a sequence).

History
This is a game of skill, related to Beleaguered Castle and Baker's Dozen. It is easier than those
games, however.



Penguin
1 Deck.

Object

To move all the cards to the Foundations.

Layout
e 4 Foundation piles (right) - build up in suit from starting card to King, Ace until each pile contains
13 cards.

e 7 cells or "flipper" piles (bottom) - storage locations for cards. Only 1 card allowed in each cell.

e 7 Tableau piles - build down by suit. Move groups of cards if they are in sequence. Spaces
can be filled only by cards one rank below the starting card of the Foundations (or Kings if
Foundations start with Aces).

Options

AutoPlay

Play

49 cards are dealt to the Tableau piles (7 each to 7 piles). The first card dealt to the first pile is
called the "Beak". The other 3 cards of the same rank as the Beak are placed as starter cards for

the Foundations. The Foundations are built up in suit, wrapping from King to Ace as necessary, until
each contains 13 cards.

The Tableau piles are built down by suit. Groups of cards may be moved if they form a descending
sequence in suit. Spaces can be filled only by cards one rank below the starting card of the
Foundations (or Kings if Foundations start with Aces).

Cards may be stored in the 7 flipper piles. Each flipper can contain only 1 cards. Any available
card may be moved to a flipper, and cards in the flipper can be moved to the Tableau or Foundations
if possible. The flipper piles perform the same function as the cells in FreeCell.

History
Penguin was invented by David Parlett, and is similar to FreeCell. Note that you must free the Beak
card in order to build the fourth Foundation.



Pyramid

1 Deck.

Object

To pair up all the cards in the deck in pairs that total to 13.

Layout

e A Pyramid of 28 cards. Only uncovered cards are available for play.

e  Stock (top left) - turn over cards one at a time by clicking. Two redeals.
e Waste (below Stock) - The top card is available for play.

Play

Pairs of cards that total to 13 (such as Queens and Aces, Jacks and Twos, etc) are removed from
play. To remove a pair, pick up one of the cards and drag it onto the other. Kings are removed
singly by clicking. Only cards that are uncovered in the Pyramid, or at the top of the Stock or Waste
piles may be removed. The objective is to remove all 52 cards from play. The Stock may be
redealt two times.

History
This is a classic solitaire game of addition.



Shamrocks
1 Deck.

Object

To move all the cards to the Foundations.

Layout
e 4 Foundation piles (top, with X's) - build up in suit from Ace to King.

e 17 Fans (below Foundations) - build up or down in sequence, regardless of suit, with a limit of 3
cards per fan. Only one card at a time may be moved. Spaces are not filled.

Options
AutoPlay
Play

The entire deck is dealt face up into 17 groups (called fans) of 3 cards, with 1 card left over. There
are 4 Foundation piles at the top of the screen. To win, build the Foundations up in suit from Ace to
King.

Only the top card of each fan is available for play. One card at a time can be moved from a fan to a
Foundation, or to another fan. The fans are built up or down in sequence, regardless of suit, with a
limit of 3 cards per fan. Spaces made by playing all the cards of a fan are not filled. There are no

redeals.

History
Shamrocks is similar to La Belle Lucie, but is easier to win.

The maximum of 3 cards in a fan means that at the beginning of the game, if no ace can be played to
a foundation, and no card can be played on top of the single card, the position is blocked. Also, in
Shamrocks the foundations should be kept as even as possible; don't play cards to the foundation
until necessary.



Stalactites
1 Deck.

Object

To move all the cards to the Foundations.

Layout

e 4 Foundation piles (top right) - build up in suit from the first card to King, Ace and so on until the
pile contains 13 cards.

e 8 Tableau piles (below Foundations) - no building is allowed. Only the top card of each pile is

available.

e 2 Cells (with X's) - storage cells for 1 card. Cards in the cells may only be moved to the
Foundations.

Play

48 cards are dealt face up into 8 piles of 6 cards each, forming the Tableau piles. The other 4
cards are dealt to 4 Foundation piles. To the left of the Foundations are two Cells.

The Foundation piles are to be built up without regard to suit, wrapping around from King to Ace as
necessary, until each pile has 13 cards. The first card of each pile is offset so you can tell when
each pile is full. The game is won if all 52 cards are played to the Foundations.

There is no building allowed in the Tableau. The top card of each Tableau pile is available for play.
Tableau cards may be moved to the Cells or the the Foundations, if possible. Only one card is
allowed in each Cell at any one time. Cards in the Cells can only be played to the Foundations-
they are not allowed to go back to the Tableau.



Strategy

1 Deck.

Object

To move all the cards to the Foundations.

Layout
e 4 Foundations (across top) - build up from Ace to King, regardless of suit.

e 8 Reserve piles (below Foundations) - cards are played here from the Stock. Cards cannot be
moved once placed.

e Stock (face down) - Top card is available for play on the Reserves. No redeal.

Play

The entire deck is dealt one card at a time. As Aces appear, they are put in the Foundation piles.
All other cards are placed on one of the 8 tableau piles. Each card may be put in any pile.

After all 52 cards have been dealt, the cards are then moved to the foundation piles in the following
way: Only the top of each tableau pile is available. The foundations are built up in suit from the
Ace up to the King. If at any time no card can be placed on the foundation, you lose. The game is
won if all 52 cards are placed on the foundation.

In effect, the entire game is played while dealing the deck and placing the cards on the tableau. If
any card is placed on a tableau pile that contains a card of the same suit and higher value, the game
will be lost. This is almost entirely a game of skill.

To play the game:

Initially all 52 cards are in the Deck pile. To move the top card on the Deck to a tableau pile, simply
click on that pile, or drag and drop the card on the desired pile. Aces are automatically moved to the
foundation piles for you as they come up in the deck.

Once the last card is committed to a tableau pile, the program automatically plays the cards to the
foundations for you. If it can play all 52 cards, you win. If not, it will stop and inform you of your
loss.

History
Strategy is a more advanced version of Sir Tommy. It was invented by Alfred Morehead and
Geoffrey Mott-Smith.



TetSol

1 Deck.

Object

To remove all cards from play in pairs.

Layout

e 15 Tableau piles, arranged in 3 columns and 5 rows - pairs of cards that total 13 and are
adjacent to each other (horizontally, vertically, or diagonally) are removed in pairs. Spaces are
filled by sliding cards down and adding cards to the top.

Play

This is a kind of solitaire version of the popular computer game Tetris. The Tableau consists of 3
columns and 5 rows of cards, 15 cards in all. Cards are removed from the Tableau in pairs that total
13 (such as a Seven and a Six), if the cards are adjacent to each other in the tableau (either
horizontally, vertically, or diagonally). To remove a pair, drop one card on the other. Kings are
removed singly. When a card is removed from the Tableau, the card above it will slide down to take
it's place, and a new card will be dealt at the top (this is where it looks like Tetris). The game is won
if all cards are paired and removed from play.

History
TetSol was invented by Randy Rasa, author of many DOS shareware solitaire games. It is easy to

play, but watch out- you can't pair up cards that are on the 1st and 3rd columns, so sometimes it is
impossible to win!



Triangle
1 Deck.

Object

To pair up all the cards in the deck in pairs that total to 13.

Layout

e Aninverted pyramid of 28 cards. Only uncovered cards are available for play.

e Stock (top left) - turn over cards one to each Waste pile by clicking. No redeals.
e 2 Waste piles (below Stock) - The top card is available for play.

Play

Pairs of cards that total to 13 (such as Queens and Aces, Jacks and Twos, etc) are removed from
play. To remove a pair, pick up one of the cards and drag it onto the other. Kings are removed

singly by clicking. Only cards that are uncovered in the pyramid, or at the top of the Waste piles
may be removed. The objective is to remove all 52 cards from play. There is no redeal.

History
This game is like Pyramid, except that the Pyramid is inverted, and there are 2 Waste piles. Itis
more difficult to win. Much depends on how quickly you can remove the tip of the pyramid.



Features

Mouse Shortcuts
Select Random Game
Add New Player
Delete Current Player
See Game Statistics
Background Color
Card Backs

Game Statistics
Game Saving

Tours

Individual Game Features
New Game

Restart Game



Select Random Game

The Select Random Game option selects one of the games at random to play.

Also, clicking on one of the icons inside the groups of games will select a game at random from
within that group.



Add New Player

The Add New Player option adds a new player to the player list. You will be asked for a name for
the new player.



Delete Current Player

Delete Current Player deletes the currently selected player from the player list. You will be asked to
confirm the action.



See Game Statistics

Shows a list of the current player's statistics for each game. The list can be sorted alphabetically by
game name, by wins, by losses, by games played, or by percentage by clicking on the appropriate
column.



Background Color

The Background Color option allows you to change the backgound color for each game. Select the
game in the box at the left and the current background color for that game will be shown. To change
the color for that game, click on the Change Color button. To save your changes, click OK. To
abandon any changes, click Cancel.



Card Backs

Selecting Card Backs from the Options menu allows you to select between 6 different card backs.
Card Backs are only visible in games where some cards are face back. Click on the card back you
want to select it.



Game Statistics

The Game Statistics option, when set, saves win and loss statistics for each game, for each player.
To see your statistics for an individual game, start the game and select Statistics from the Options
menu. You can reset the statistics at any time.

If you do not want statistics of your performance kept, simply unselect this option. Your current
statistics will remain, but no new results will be added until you select the option again.

Different player names can set this option individually.



Game Saving

The Game Saving option, when set, saves the game positions of every game upon exit. This
means that if you are interrupted during play, and exit the game, you can return to the same position
the next time you play.

When this option is not set, the game positions are not saved. Turning off the option will also delete
all currently saved positions.

Different player names can set this option individually.



Tours

The Tours feature allows you to play a sequence of games with a cumulative score kept. Several
predefined tours are available, and you can also create your own.

Play Tour
Create Tour

Edit Tour
Delete Tour



Play Tour

Click on the tour name that you want to play. All tours available to the current player will be listed.



Create Tour

The Create Tour feature allows you to create your own tours. First, type in the name of the tour you
want to create in the top box (You can name a tour anything, as long as it is not the same as an
already existing tour). Then, click on game names in the left box to add games to the tour. If you
want to delete a game from the tour, click on its name in the right box. When finished, click on OK.
You can cancel at any time by clicking on the Cancel button.



Edit Tour

The Edit Tour feature allows you to edit tours you have already created (Note: you can't edit the
predefined tours that come with Pretty Good Solitaire). First, select the name of the tour you want to

edit in the top box. Click on games that you want to add to the tour in the left box. Click on games
you want to remove from the tour in the right box.

If you have not created any tours to edit, then Edit Tour will create a tour.



Delete Tour

The Delete Tour feature will delete a tour. Click on the name of the tour to delete it. Note: you
cannot delete the predefined tours that come with Pretty Good Solitaire.



New Game

Selecting New Game from the Game menu will deal out a new deck. If you are in the middle of a
game and Game Statistics is on, a loss will be added to your statistics.



Restart Game

Selecting ReStart Game from the Game menu will start the current game over again from the
beginning. This will not affect your statistics.



Undo

Selecting Undo from the Options menu will undo the last move. Moves can be undone back to the
beginning of the game (of course, ReStart Game would be easier in this case).



Redo

Selecting Redo from the Options menu will replay any moves you have undone, in case you
change your mind.



About

Pretty Good Solitaire 2.1
Copyright © 1995, 1996 Tom Warfield All Rights Reserved.

Thomas Warfield
PO Box 9155
Springfield IL 62791-9155 USA

Technical Support is available by e-mail to: GoodSol@aol.com or on Compuserve: 75237,254.
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Version History

Version 1.0 - released 7/19/95 - contained the original 5 games, FreeCell Towers, Baker's Dozen,
Golf, Fourteen Out, and Yukon.

Version 1.1 - released 8/15/95 - bug fixes on FreeCell Towers, Baker's Dozen, and Yukon. Five new
games- Busy Aces, 5 Piles, EastHaven, La Belle Lucie, and St. Helena.

Version 1.2 - released 9/25/95 - added 5 new games- Spiderette, Eagle Wing, Deuces, Perpetual
Motion, and Storehouse.

Version 2.0 - released 11/15/95 - complete re-write of all the games, collapsed all the games into one
executable file, added 15 new games and many new features, such as player names and game
saving on exit.

Version 2.1 - released 6/?/96 - added 30 new games, bringing the total to 60. Also added tours.

Vendor Information

Pretty Good Solitaire version 2.1 may be distributed via BBSs, online services, and the Internet, as
long as all files (GOODSOL2.EXE, GOODSOL2.HLP, QCARD.DLL, CMDIALOG.VBX, and
README.1ST) are present and unmodified. Diskette and CD-ROM vendors should direct inquiries to
the author at the postal or email addresses above.



Red and Black

2 Decks.

Object

To move all cards to the Foundations.

Layout
e 8 Foundation piles (across top) - build up in opposite colors from Ace to King.

e 8 Tableau piles (below Foundations) - build down by opposite colors. Groups of cards can be
moved. Spaces filled by any card.

e Stock (bottom left) - turn over 1 card to Waste by clicking. No redeal.
e Waste (next to Stock) - Top card is available for play.

Options

AutoPla

Play

The 8 Aces are removed and placed in a row to become the Foundations. These Foundations will
be built up in opposite colors to Kings. | repeat, in opposite colors! Suits are meaningless. This is
different from most games. The game is won if all the cards are moved to the Foundations.

Below the foundations a row of 8 cards is dealt, to become the Tableau. The Tableau piles are built
down by opposite colors. A group of cards can be moved onto another pile, if possible. Spaces
can be filled by any card.

The remainder of the deck is dealt to the Stock pile. The Stock pile is turned over one card at a time
(by clicking on the Stock) onto the wastepile. The top card of the wastepile is available for play on
the Tableau or Foundations. There is no redeal.

History
This game was named "Rouge et Noir" in version 2.0 of Pretty Good Solitaire.









